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ЛАБОРАТОРНАЯ РАБОТА 

 

 Цель работы:  ознакомиться с принципом работы радиомодуля 

DP1201A, научиться его программировать и передавать информацию. 

 

Используемые устройства и программы: 

1. Персональный компьютер. 

2. Отладочная плата для микроконтроллера С8051F060 с радиомодулем 

DP1201A. 

3. Интегральная среда разработки Silicon Laboratories IDE. 

 

Задания 

1. Осуществить передачу по радиоканалу данных без формирования 

защищенного пакета. Визуально определить радиус действия. Сделать 

выводы. 

2. Осуществить передачу по радиоканалу данных с формированием 

защищенного пакета. Визуально определить радиус действия. Сделать 

выводы. 

3. Организовать двухстороннюю радиосвязь с возможностью 

осуществления запроса (со стороны приемника) повторной передачи 

пакета, если предшествующий - получен некорректно. 

4. Измерить температуру в лаборатории с  помощью датчика DS18B20 и 

передать результат в другое помещение. Осуществить вывод 

информации на семисегментные индикаторы. 

5. Измерить давление датчиком МРХ4250АР и передать  результат в 

другое помещение. Осуществить вывод информации на 

семисегментные индикаторы. 

6. Организовать сеть на основе радиоканала, передавать информацию о 

температуре на ведущий контроллер. Температуру отображать на ЖК- 

индикаторе, на первой строке расположить имя датчика, на второй – 

показания.  

7. Управление шаговым двигателем с помощь радиоканала.   

Результат показать преподавателю. 

 

Содержание отчета 

 

1. Цель работы. 

2. Задание. 

3. Используемые устройства и инструментальные программы. 

4. Алгоритм программы. 

5. Программа, написанная Вами при выполнении задания с пояснениями. 

6. Вывод по проделанной работе.  
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Контрольные вопросы 

 

1. Области применения радиомодулей. 

2. Какая модуляция применяется в данном радиомодуле? 

3. Что такое девиация частоты? 

4. Как перевести значение мощности из дБм в мВт? 

5. Почему значение девиации частоты должно быть больше скорости 

передачи данных, но меньше фильтра основной полосы частот? 

6. Какими характеристиками должно обладать нелицензируемое 

устройство радиосвязи? 

 

Краткие теоретические сведения 

Широкое применение радиомодулей для передачи данных в 

современной промышленности связано, прежде всего, с прямой 

экономической выгодой. Передача информации с применением таких 

интерфейсов как RS-232, RS-485 и Hart-протокол предусматривает наличие 

проводной линии связи. Зачастую обеспечение этой линии затруднительного 

(требует серьезных экономических и временных затрат), или, того хуже, 

невозможно в силу различных факторов. И в этом случае применение 

радиосвязи является отличным решением.  

На данный момент  многими фирмами разработано большое 

разнообразие радиомодулей способных обеспечить качественную связь 

между устройствами производства. К числу этих фирм относятся Panasonic, 

Radiotronix, Yishi Electronics, HopeRF Electronic, Xemics и многие другие.  В 

данной методике предоставлена информация для реализации радиоканала на 

основе радиомодуля DP1201A фирмы Xemics, установленного на платформе 

с контроллером С8051А060 фирмы Silicon Laboratories.  

 

1 Приемопередатчик DP1201A 

DP1201A – функционально завершенный приемопередающий 

радиомодуль, работающий в безлицензионном диапазоне частот 433 МГц. 

Благодаря широкому диапазону питающих напряжений, модуль может найти 

применение в различных устройствах с батарейным питанием. Радиомодуль 

имеет уникальные характеристики энергопотребления.  

Интерфейс с модулем DP1201A полностью цифровой (8 линий) и не 

требует от разработчика знаний в области ВЧ электроники. Модуль DP1201A 

может быть использован в любых приложениях, использующих 

дистанционный обмен информацией. DP1201A оптимизирован для 

приложений, предъявляющих к компонентам такие требования, как: 

небольшие размеры компонентов, низкую стоимость, малое 

энергопотребление. В составе радиомодуля применяется интегрированный 

полудуплексный трансивер (XE1201A), работающий в частотном диапазоне 

433 МГц. Модуляция – 2-CPFSK (Continuous Phase, 2 level Frequency Shift 
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Keying). Встроенный синхронизатор данных позволяет подключать 

недорогие микроконтроллеры с минимальными схемотехническими 

затратами.  

 

1.1  Основные характеристики 

Таблица 1 – Основные характеристики 
Параметр  Условие Мин. Тип. Макс.  Ед. изм. 

Несущая частота   433,93  МГц 

Напряжение питания  2,4 3,0 5,5 В 

Ток потребления в 

режиме Stand-by 

Тактирование включено - 55 65 мкА 

Тактирование включено - 0,2 1 мкА 

Передатчик  

Ток потребления  Выходная мощность +5дБм  13,5  мА 

Выходная мощность 

С13 = 1 С12 = 1  +5  дБм 

С13 = 1 С12 = 0  +2  дБм 

С13 = 0 С12 = 1  -10  дБм 

С13 = 0 С12 = 0  -15  дБм 

Девиация частоты Программируемая 4 125 200 кГц 

Скорость передачи Программируемая 4  64 кБод 

Приемник  

Ток потребления  4,5 6 7,5 мА 

Чувствительность  BER<1%, DR = 8 кБод  -109  дБм 

Цифровой интерфейс 

Низкий уровень вх/вых   0 - 0,4 В 

Высокий уровень 

вх/вых 
 2,6 - 3 В 

Время установки 

данных (Tsu) 
Рис. 1.2 125 - - нс 

 

 

Рис. 1.1 Расположение выводов приемопередатчика DP1201A 

 

 

 

 



 6 

Таблица 2 – Назначение выводов модуля 
Номер Символ Параметр 

1 VDD Напряжение питания 

2 GND Земля 

3 EN Разрешение работы микросхеме 

4 DE Разрешение 3х-проводной шины 

5 SC Тактирование 3х-проводной шины 

6 SD Вход данных 3х-проводной шины 

7 RxTx Включение приемника/передатчика 

8 NC Не используется 

9 TxD Вход шины данных 

10 CLKD Тактирование шины данных 

11 RxD Выход шины данных 

12 GND Земля 

13 NC Не используется 

14 GND Земля 

15 RF I/O Радиочастотный вход/выход 

16 NC Не используется 

 

1.2  Описание работы 

Интегральный трансивер ХЕ1201А управляется через 3х-проводную 

последовательную шину  (SD, SC, DE) согласно диаграмме, показанной на 

рисунке  1.2, 

 
Рис. 1.2 Временная диаграмма 3х-проводной шины 

 Настройки записываются в три регистра A, B и C, которые адресуются 

согласно таблице 3. 

Таблица 3 – Адресация регистров 
D15 D14 Имя регистра  

0 0 Регистр А 

0 1 Регистр В 

1 0 Регистр С 

1 1 Не используется  

 При конфигурации радиомодуля регистры заполняются данными от 

А13 до А0, от В13 до В0 и от С13 до C0 согласно содержимому битов D15 и 

D14. Данные в регистры поступают начиная со старшего байта и 

записываются по переднему фронту тактирующего сигнала. Для доступа к 

3х-проводной шине необходимо линию DE притянуть к земле. Переход лини 

в высокое состояние, говорит о том, что регистр заполнен. Значения в 

регистрах сохраняются до тех пор, пока есть питание.  
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Рис. 1.3  Структурная схема интегрального трансивера XE1201A 

Для приема и передачи собственно данных трансивер имеет две 

однонаправленные линии приема (TxD) и передачи (RxD), и выходную 

линию синхронизации данных (CLKD). Таким образом, приемопередатчик 

может работать как в синхронном так и в асинхронном режиме приема 

данных. 

 

Выводы RxTx и EN 

RxTx (прием/передача) и EN (разрешение работы) эти выводы активны, 

когда сброшен бит A13 в регистре А. В этом режиме XE1201A может быть  

включен или выключен, а так же переведен в режим приема или передачи 

манипуляциями с выводами RxTx и EN согласно таблице: 
EN RxTx Режим  

0 Х Микросхема выкл. 

1 0 Режим передачи 

1 1 Режим приема 

 

Регистр А (D15=0, D14=0) 

 

A13 – Бит контроля режима 

Когда установлен в 0, выбор режим приема или передачи, а  так же 

разрешение работы кристалла (ЕN) осуществляется через вывод 15 (RXTX) и 

вывод 1 (EN). Кода установлен в 1, выбор режим приема или передачи, а так 

же выбор разрешение работы осуществляется настройкой битов А10 и А11. В 

этом режиме управляющие сигналы, подаваемые на выводы 15 и 1, 

игнорируются.   

 

А12 - Тактирование 

Этот бит используется для внутреннего запуска синхроимпульсов 

XE1201A. Когда установлена 1,  тактовый генератор всегда работает 

независимо от того, какое значение имеет бит разрешения работы (A11 когда 
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A13=1 или вывод 1 когда A13=0). Когда установлен в 0, активность 

тактового генератора определяется содержимым бита А11. 

 

А11 – Разрешение работы чипа 

Когда установлен 0, все блоки микросхемы XE1201А дезактивированы 

(за исключением тактового генератора, если бит А12 = 1). Однако, 3-х 

проводная шина остается активной в блокированном режиме, пока есть 

питание микросхемы. Этот бит заменяет вывод EN (вывод1), когда А13 = 1. 

 

А10 – Режим приема/передачи 

Когда установлена 1, ХЕ1201А находится в режиме приема и в режиме 

передачи если 0. Этот бит заменяет вывод RXTX (вывод 15), когда А13 = 1. 

 

A9 ,A8 ,A7, A6 – Демодулятор и обход битового синхронизатора 

Этот биты используются, когда нет необходимости в битовом 

синхронизаторе, например, во время выхода из спящего режима в режим 

приемника. 

 а) Приемник в нормальном режиме, но демодулятор не используется. 

Выходы I и Q триггера доступны на выводах 19 и 18. Биты с А9 по А6 

должны быть установлены согласно таблице: 
А9 А8 А7 А6 

0 1 0 0 

 

 б) Приемник в нормальном режиме, но внутренний битовый 

синхронизатор выключен. Входные данные доступны на выводе RXD (вывод 

19). CLKD (вывод 18) бесполезен. В этом режиме нет необходимости в 

преамбуле для синхронизации битового синхронизатора, так что время 

пробуждения минимально. Биты А9-А6 должны быть установлены согласно 

таблице: 
А9 А8 А7 А6 

0 1 0 1 

 

A5, A4, A3, A2, A1, A0 – Скорость передач данных 

Эти биты используются для установки скорости передачи данных, 

согласно формуле: 

8265574

n

=DR  [Гц]. 

 

Когда n -  целое число.  Обратная функция дает значение n при требуемой 

скорости передачи данных в Гц: 

2

104

61
8

6

Log

DR
Log

ROUND=n . 
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Регистр В (D15=0, D14=0) 

 

B13, B12, B11, B10, B9, B8, B7 – Частота смещения несущей 

Этот бит может быть использован для калибровки частоты 

центрального генератора. Частотное смещение может быть прибавлена или 

вычтена из частоты локального генератора в течении передачи согласно 

формуле: 

 

DFC = 3906.25 • n [Гц] 

 

где n – знаковая величина установленная в В13-В7 (от -64 до +63). Таким 

образом, смещение может колебаться от -250000 Гц (1000000b) до 246093.75 

Гц (0111111b). 

  

B6, B5, B4, B3, B2, B1, B0 – Тестовые биты 

Эти биты только для тестового назначения. Они должны быть всегда 

установлены в ноль. 

 

Регистр С (D15=0, D14=0) 

 

C13, C12 – Выходная мощность передатчика 

Выходная мощность на выводе RFOUT (вывод 29) может быть 

отрегулирована при помощи битов С13 и С12 согласно таблице: 

 
С13 С12 Выходная мощность 

0 0 -15 дБм 

0 1 -5 дБм 

1 0 2,5 дБм  

1 1 +5 дБм 

 

 

C11 – Бит инвертирования данных 

 

ОБРАТИТЕ ВНИМАНИЕ! 

Поток входных данных инвертируется, когда бит сброшен. 

 

C10, C9 – Тестовые биты 

Эти биты должны иметь всегда значения С10 = 1 и С9 = 0. 

 

 

C8 – Бит управления выходным усилителем 

Когда этот бит сброшен, выходной усилитель отключен независимо от 

того, в каком состоянии находится передатчик. 
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C7 – Бит передаваемых данных  

Этот бит заменяет вывод TXD (вывод 17), когда бит А13 установлен в 1, 

таким образом, позволяет передавать данные через 3-х проводную шину. 

 

C6, C5, C4, C3, C2, C1, C0 – Девиация частоты модулятора 

Эти биты используются для настройки девиации частоты модулятора 

согласно формуле:   

FDEV = 3906,25• n [Гц] 

 

где n – целое число. Девиация частоты передатчика теоретически может быть 

увеличена до значения 496093,75 Гц. Однако, нужно заметить, что для 

присущего режима демодулятора XE1201A, девиация частоты должна быть 

больше чем скорость передачи данных (FDEV> DR) и менее, чем ширина 

полосы фильтра основной полосы частот. 

 

 Значение регистров по умолчанию 

После включения питания регистры А, В и С имеют следующие значения: 
   Б 

Р 

Адрес Данные 

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

А 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 

В 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

С 1 0 0 1 0 1 0 1 0 0 1 0 0 0 0 0 

 

ОБРАТИТЕ ВНИМАНИЕ, ЧТО ПО УМОЛЧАНИЮ БИТ С11 СБРОШЕН!!! 

 

Согласно этим значениям трансивер имеет следующие настройки: 

 тактовый генератор выключен; 

 скорость передачи данных 16 кБод; 

 выходная мощность -5 дБм; 

 девиация частоты 125 кГц; 

 трансивер готов приему или передачи (зависит от состояния на  RxTx). 

 

Синхронизация в режиме приема 

Режим приема основан на автоматической подстройке частоты, 

контролируемой АЛУ. Для гарантированной синхронизации внутреннему 

демодулятору XE1201A необходим фрейм из 20 синхронизирующих битов. 

Синхронизирующий фрейм может быть последовательностью 0 и 1. 

 

2. Краткое описание отладочных средств 

 

2.1 Общее описание внутрисхемного 

отладчика и Silicon Laboratories IDE 

 

Silicon Laboratories IDE – интегрированная среда разработки, 

представляет собой программный продукт, работающий под управлением 
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операционной системы Windows и предназначенный для написания, отладки 

и оптимизации программ для контроллеров Cygnal. Silicon Labs IDE 

включает в себя: 

 

Project Manager – менеджер проекта, позволяет создавать, сохранять текущие 

проекты; 

Editor – текстовый редактор для написания программы; 

Simulator – симулятор для проверки функционирования программы; 

Keil Assembler – язык программирования 

Linker – утилита объединения всех файлов проекта 

Compilar – утилита преобразования программы в машинные коды 

 

ВАЖНО: Silicon Laboratories IDE работает только с 

подключенным к компьютеру контроллером. 

 

2.2 ICD 

 

ICD работает под управлением программной среды Silicon Laboratories и 

обладает следующими возможностями: 

 Отладка в режиме реального времени с возможностью пошаговой 

отладки 

 Связь с компьютером по USB – интерфейсу 

 Просмотр и модификация содержимого управляющих регистров, RAM 

и EEPROM 

 Внутрисхемная отладка и встроенная система программирования 

контроллера Cygnal 

 Содержит богатую систему визуального вывода информации 

 
Рис 2.1 – Внешний вид отладочного модуля 
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2.3 Работа в среде Silicon Laboratories и работа с внутрисхемным 

отладчиком 

 

 

Рис. 2.2 Интерфейс среды разработки SiLabs IDE 

 

Всплывающее меню File 

 

Во всплывающем меню File доступны следующие опции: New File, 

Open File, Close File, Save, Save As, Save All, Print Setup, Print 
 

 

Эти опции предназначены для создания, 

сохранения, открытия и закрытия файлов.  
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Всплывающее меню View 

 

Во всплывающем меню View доступны следующие опции: Debug Windows, 

Project Window, Output Window, Toolbars, Status bar, Workbook Mode. 
 

 

 
 

 

Debug Windows. Для просмотра и отработки программы 

предусмотрены специальные окна, отображающие содержимое специальных 

регистров, памяти и т.д. Чтобы вызвать данные окна, нажимаем View>Debug 

Window 

 

 SFR’s – окно регистров специального назначения 

 Watch Window – собственное окно просмотра 

 Registers – окно просмотра содержимого регистров 

 RAM – окно просмотра содержимого ячеек памяти 

 Code Memory – окно просмотра содержимого области памяти 

 Disassembly – окно, отображающее команды на языке ассемблер 

 External Memory - окно просмотра содержимого ячеек внешней памяти 

 Stack – окно просмотра содержимого Стека 
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Создание нового проекта 

 

1)Выберете из меню Project>New Project 

 

В результате в «Окне проекта», находящегося слева, появится 

«дерево», как показано на рисунке 
 

2) Выбрать из меню File>New file, тем самым создать бланк программы 

 

 

                     
 

 

3) Теперь сохраняем этот бланк нажав File>Save file ,указав его название и 

расширение  (например blink.asm) 

 

4) нажимаем правой кнопкой на «корень дерева» Вашего проекта, как 

показано на рисунке и добавляем созданный Вами бланк программы 
 

  

5) Сохраняем созданный проект с указанием его названия, нажав 

Project>Save Project. 

Теперь можно приступить к написанию вашей программы. 

 

Функции необходимые для работы 

 

 Подключение Debug>Connect  

 Компиляция проекта Project>Assemble/Compile File 

 Пошаговое выполнение программы Debug>Step 

 Сброс контроллера Debug>Reset 

 Запуск выполнения Debug>Run 

 

В контроллер можно загрузить только откомпилированный проект, не 

содержащий ошибок. Компиляция не произойдет, если на пути к каталогу, 

содержащему компилируемый файл, имеются русскоязычные символы. 
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Порядок работы при загрузки программы в контроллер 

 

Assemble/Compile File (Ctrl+F7) 

Build/Make Project (F7) 

Connect (Alt+C) 

Download code (Alt + D) 
 

Поскольку компилировать программу приходится каждый раз, перед 

тем как загрузить в память контроллера, то кнопка загрузки в контроллер 

будет неактивна до момента успешного окончания компиляции. 

Написав программу, можно посмотреть, как она функционирует. Для 

этого необходимо откомпилировать программу и записать в контроллер, 

после чего можно приступить к отладке. 

Внизу экрана располагается область, называемая Output Window. Она 

предназначена для сообщения пользователю о наличии или отсутствии 

ошибок в программе. 
 

 

 
  

 

Это сообщение появится после компиляции проекта. Если программа 

содержит ошибки, то в сообщении будет указанно, в какой строке допущена 

ошибка, и что именно неверно.  

 

ВАЖНО! При наличии ошибок программа не будет записана в 

контроллер. 

 

Для отладки следует открыть нужные окна отладчика (Debug Window) 

и производить «манипуляции» с программой. 

Для этого имеется специальное средство, называемое Breakpoint, то 

есть точка останова. Для того чтобы поставить еѐ на какой-нибудь строке 

программы, нужно нажать на ней правой кнопкой мыши и выбрать 

Insert/Remove Breakpoint. 
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Если точка останова была установлена, то на поле слева появится 

значок, означающий, что на этом месте программа остановится, и будет 

ждать дальнейших указаний. 

 
  

 
 

 

Для того чтобы снять эту точку, необходимо ещѐ раз проделать данную 

процедуру.  

 Стрелка синего цвета, располагаемая на том же поле, что и Breakpoint, 

указывает на ту строчку, которая будет выполнена на следующем шаге. 
 

 

 
 

 

Также в отладочном средстве имеется возможность указывать 

выполнение программы до определенной строки без установки breakpoint. 

Это может оказаться полезным в том случае, если необходима разовая 
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проверка выполнения программы до этой строки. В этом случает, на нужной 

строке нажимаем правой кнопкой мыши и выбираем Run to Cursor. 
 

 

 
 

 

Программа выполнится до указанной строки и остановится. После 

этого можно пронаблюдать содержимое регистров и т.д., чтобы 

удостовериться в правильности исполнения программой поставленной 

задачи. Когда вся работа будет выполнена, можно снова запустить 

программу. Она продолжит выполнение с того места, на котором была 

остановлена. 
 

Пример настройки радиомодуля: 
<вырезано>  

DE = 0; 

 for (i=0; i<500; i++); 

 

 SD = 0;     //A15 старший бит адреса регистра А  

 for (i=0; i<110; i++); 

 SC = 1; 

 for (i=0; i<110; i++); 

 SC = 0; 

<вырезано>  

 

Пример настройки UART1: 
<вырезано>  

TCON |= 0x40; // Включение таймера 

TMOD |= 0x20; // Режим работы: 8-разрядный таймер/счетчик с 

//автоперезагрузкой 

CKCON |= 0x00; // Тактируется системными тактовым сигналом диленым на 12   

TH1 = 0xA0;  // Значение  старшего байта таймера1, скорость передачи 

   //  данных 115 кбод 
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SFRPAGE = UART1_PAGE; 

SCON1 |= 0x70;  // Настройка модуля УАПП1 на прием/передачу 

SFRPAGE = SPI0_PAGE; 

SPI0CFG |= 0x40;  // Ведущий режим SPI0 

SPI0CN = 0x03;  // Включение, 3х-проводного режима 

<вырезано>  

 

Пример подпрограммы приема пакета: 
<вырезано>  

 while(1) 

 { 

  SFRPAGE = UART1_PAGE; 

  if (SCON1&0x01 == 0x01)  

{ 

   SCON1 &= 0xfE; 

   buf1 = SBUF1; 

   if (bn == 0xff) 

   { 

   if (buf1 == 0xe7) bn = 0x00;   

   }  

   else{ 

    if (bn == FrameLength+0x01)  

    {CRC = buf1; 

    bn = 0xFF;  

    test--;} 

    if ((bn < FrameLength+0x01) & (bn > 0x00)) 

    {ReadByte[bn-0x01] = buf1; 

    bn++;} 

    if (bn == 0x00)  

{      

     if (buf1 < 0x06)  

     {FrameLength = buf1; 

     bn++;} 

else{bn = 0xff;}  

     } 
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   } 

   if (CRC == (ReadByte[0]^ReadByte[1])) 

      { 

      resl = ReadByte[0]; 

   resh = ReadByte[1]; 

   } 

  } 

  indication(); 

     SFRPAGE = CONFIG_PAGE; 

 }  

<вырезано>  

 

Работа заключается в следующем; при получении байта 

осуществляется проверка на маркер начала кадра, и если счетчик принятых 

байт (bn) равен 0хFF, начинается процедура приема пакета. Счетчик 

принятых байт обнуляется. Следом за маркером поступает байт, содержащий 

информацию о количестве информативных байт (FrameLength), исходя из 

этого значения, заполняется массив принятых байт (bn инкрементируется с 

каждым новым принятым байтом), как только счетчик принятых байт 

достигнет значения на единицу превышающее значение FrameLength,  

прекратится прием данных и произведется проверка на контрольную сумму. 

Если данные приняты корректно, контрольная сумма совпадет,  начнется 

процедура инициализации. 
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ПРИЛОЖЕНИЕ А 

Принципиальная схема устройства 
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